
 

 NetBackup 

Technical FAQ 

 

NetAccess Systems Inc. Page 1 of 26 (October 7, 2009) 

 

Table of Content 
 

1. General..................................................................................................................... 4 

1.1. Can you briefly explain the idea of how the NetBackup Software works? ........................................ 4 

2. NetBackup Manager ................................................................................................ 5 

2.1. What is the recommended bandwidth? .............................................................................................. 5 
2.2. How do I run NetBackup Manager with Microsoft ISA 2004? ......................................................... 5 
2.3. How do I install NetBackup Manager on FreeBSD? ......................................................................... 5 
2.4. How do I install NetBackup Manager on SCO Unix? ....................................................................... 6 
2.5. How do I install NetBackup Manager on AIX? ................................................................................. 6 
2.6. The Windows version of NetBackup Manager installer hangs, what could be the problem? ............ 6 
2.7. The Installer doesn‟t seem to work. How can I manually install NetBackup Manager on 

Windows? .......................................................................................................................................... 7 
2.8. The Installer doesn‟t seem to work. How can I manually install NetBackup Manager on Mac?....... 7 
2.9. Error occurred when Installing NetBackup Manager on Novell. ....................................................... 7 
2.10. Are there any command line tools for NetBackup Manager? ............................................................ 8 
2.11. How does NetBackup Manager detect changes in files? Does it use the Archive bit? Some tape 

backup software resets the Archive bit. Would this affect NetBackup Manager when backing up 

the same data? ................................................................................................................................... 9 
2.12. Does NetBackup Manager copy the same set of files regularly? ....................................................... 9 
2.13. Transfer Block Size is 128Kb by default. Is there a reason for this? ................................................. 9 
2.14. How can I backup a huge data set over the Internet? ......................................................................... 9 
2.15. What is the best way to restore a huge data set? ................................................................................ 9 
2.16. Does In-File Delta backup require a temporary working directory? .................................................. 9 
2.17. What is the average compression ratio? .......................................................................................... 10 
2.18. Can I change my encrypting key? ................................................................................................... 10 
2.19. If the “Use Login Password as Encrypting Key” option was selected when creating the backup 

set. Why I cannot restore the backup data with my most current login password? .......................... 10 
2.20. What kind of encryption used by NetBackup Manager? ................................................................. 10 
2.21. When select the backup option “local hard drive” to backup to external hard drive, it fails in the 

middle of the process, why? ............................................................................................................ 11 
2.22. Scheduled backup jobs are not running on my Windows machine, why? ....................................... 11 
2.23. I am having problems with my scheduled backup, why? ................................................................ 11 
2.24. I cannot get proxy authentication to work with NetBackup Manager, why? ................................... 11 
2.25. Can I backup an entire Operating System? ...................................................................................... 11 
2.26. When setting up a Microsoft SQL Backup Set, I cannot list the available SQL servers, what can 

I do? ................................................................................................................................................. 12 
2.27. Why are the Microsoft SQL Server databases missing from the backup source list? ...................... 12 
2.28. How to set the recovery model of a MS SQL database to FULL? ................................................... 12 
2.29. Windows network map drive connections are not stable, why? ...................................................... 12 
2.30. There is an error when backing up files on a remote NetWare server, what can I do? .................... 13 
2.31. What are the advantages and disadvantages of backing up multiple computers using a single 

backup account? .............................................................................................................................. 14 
2.32. How to find out which version of the client software the user is using? ......................................... 14 
2.33. Does the NetBackup Manager upgrade the installation of Java on a client machine, or does it 

install a separate copy for its own use?............................................................................................ 14 
2.34. After upgrading NetBackup Server, do I have to upgrade all the NetBackup Manager as well? 

And do I need to transform/migrate their current data? ................................................................... 14 
2.35. Is it possible to do incremental or differential backups with MySQL? ............................................ 15 
2.36. How does the “Remove retention files for overlap policy” under Advanced Retention Policy 

work? ............................................................................................................................................... 15 
2.37. What is incremental backup and how does In-File Delta work? ...................................................... 15 



 

 NetBackup 

Technical FAQ 

 

NetAccess Systems Inc. Page 2 of 26 (October 7, 2009) 

 

2.38. How does the “Auto” block size work under In-file Delta settings? ............................................... 15 
2.39. What happens when we do In-File Delta backup on a directory? .................................................... 16 
2.40. Does NetBackup Manager have to stop the application when doing online backups? .................... 16 
2.41. What are Off-line backup, Logout backup reminder and Local backup features? ........................... 16 
2.42. Why is my NetBackup Manager running backup once every hour? ................................................ 16 
2.43. How do I disable “logout backup reminder”? .................................................................................. 17 
2.44. How do I upgrade NetBackup Manager from V4.5 on Linux? ........................................................ 17 
2.45. How do I change the .obm path for Novell? .................................................................................... 17 
2.46. The MS SQL or MS Exchange database backup job stores 2 copies of the spooled database file 

in the "temporary directory" (tagged with different datetimes). This has taken up extra disk 

space, is this necessary? .................................................................................................................. 17 
2.47. What do I have to do in order to backup open files? ....................................................................... 18 
2.48. How does Volume Shadow Copy work? ......................................................................................... 18 
2.49. In Windows, when NetBackup Manager is creating Shadow Copy Set, it gets the “[ERROR] 

E_UNEXPECTED” error, what can I do? ....................................................................................... 18 
2.50. How to backup Oracle 7.3.4 on NetWare? ...................................................................................... 18 
2.51. How do I backup NTFS permission? ............................................................................................... 18 
2.52. How do I restore NTFS permission? ............................................................................................... 19 
2.53. How do I backup file permission in Linux? .................................................................................... 19 
2.54. How do I restore file permission in Linux? ..................................................................................... 19 
2.55. How do I remove NetBackup Manager completely from my Windows machine? .......................... 19 
2.56. Does NetBackup Manager work with dial-up connections? ............................................................ 20 
2.57. The NetBackup Manager crashes when opening [Backup Source] of a Lotus Domino/Notes 

backup set, what can I do? ............................................................................................................... 20 
2.58. How do I restore a machine from my SystemState backup?............................................................ 20 

3. Common Error Messages ...................................................................................... 21 

3.1. "Quota Exceeded" ........................................................................................................................... 21 
3.2. "Access is denied" ........................................................................................................................... 21 
3.3. "Checksum incorrect" / "Uploaded file size incorrect" .................................................................... 21 
3.4. "File 'obm-delta.tmp' does not exist on server" / "File 'obm-chksum.tmp' does not exist on 

server" ............................................................................................................................................. 21 
3.5. "C:\xxx\yyy\zzz.txt has been removed already" .............................................................................. 21 
3.6. "The process cannot access the file because another process has locked a portion of the file" ....... 22 
3.7. "The process cannot access the file because it is being used by another process" ........................... 22 
3.8. "Premature end of input" ................................................................................................................. 22 
3.9. "Invalid XML Character" / "XML document structures must start and end within the same 

entity" .............................................................................................................................................. 22 
3.10. "Incorrect Function" ........................................................................................................................ 23 
3.11. "HTTP/1.1 502 Proxy Error" ........................................................................................................... 23 
3.12. " [Microsoft][ODBC SQL Server Driver][SQL Server]The statement BACKUP LOG is not 

allowed while the recovery model is SIMPLE" ............................................................................... 23 
3.13. "CExBackup::backupService:HrESEBackupSetup: Error Number 0xc800020e: An incremental 

backup cannot be performed when circular logging is enabled" ..................................................... 23 
3.14. "CExBackup::backupStorageGroup:HrESEBackupTruncateLogs: Error Number 0xc7ff1004: 

(null) " ............................................................................................................................................. 24 
3.15. "CExBackup::backupStorageGroupLog:HrESEBackupGetLogAndPatchFiles: Error Number 

0xc8000232: Some log or patch files are missing" .......................................................................... 24 
3.16. "CExBackup::backupFile:WriteFile: Error Number 0x6: The handle is invalid" ............................ 24 
3.17. "Path „C:\Temp\MSSQLServer\1137040769567‟ does not exist" ................................................... 24 
3.18. "Expect log sequence 'xxx' but found 'SERVERNAME\Microsoft Information Store\First 

Storage Group\E000xxx.log'" .......................................................................................................... 25 
3.19. "The last backup jobs of *.stm (2006-10-30-13-40-21) and *.edb (2006-11-04-03-05-00) don‟t 

match for database 'ServerX\Microsoft Information Store\First Storage Group\Mailbox Store 

(ServerX)'" ...................................................................................................................................... 25 



 

 NetBackup 

Technical FAQ 

 

NetAccess Systems Inc. Page 3 of 26 (October 7, 2009) 

 

3.20. "No *.stm found for database 'ServerX\Microsoft Information Store\First Storage 

Group\Mailbox Store (ServerX)'" .................................................................................................... 25 
3.21. Exception in thread "main" java.lang.UnsatisfiedLinkError: 

/usr/local/obm/jvm/lib/i386/libawt.so: libXp.so.6: cannot open shared object file: No such file 

or directory… .................................................................................................................................. 26 
 

 

 

 

 

Note 

If you are branding this document for your customers, please be reminded to: 

1. Modify the “header” and “footer” of this document 

2. Change all references of www.NetAccess.com to your server 

3. Take away those sections that are not relevant to your customers, e.g. the 

section on “Branding” 
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1. General 

1.1. Can you briefly explain the idea of how the NetBackup Software 
works? 

The NetBackup Suite consists of 3 main modules: 
 

1. The client software – NetBackup Manager (NetBackup Manager) and A-Click 
Backup Client (NetAccessACB) 

2. The server software – NetAccess Offsite Backup Server (NetBackup Server) 

3. The replication server – NetAccess Replication Server (NetAccessRPS) 

 
NetBackup Manager is a client application with a user-interface for easy backup 
configuration. It allows users to upload selected files to the Backup server and runs 
scheduled backup jobs. It also allows users to create different backup sets for different 
backup purpose. Besides file backup, NetBackup Manager can backup a list of applications 
such as MS Exchange, MS SQL, Oracle, MySQL, Lotus Domino, and much more. NetBackup 
Manager supports Windows 2000, XP, 2003, Vista, Linux, Mac OS X, etc. 
 
NetAccessACB is a client application with essential file backup functionalities and an 
intuitive user-interface targeting for simple end-users. It allows users to upload selected files 
to the Backup server and runs scheduled backup jobs.  
 
NetBackup Server is a server application which store backup data from multiple NetBackup 
Managers backup accounts. It has a web-based Management Console for system 
administrators to manage the Backup Server, such as configuring system and backup 
account settings, and viewing backup statistics and reports. Users can also logon to this 
Management Console to manage their own backup account or restore their own backup data. 
NetBackup Server supports Windows, Linux and Mac OS platforms. 
 
NetAccessRPS is another server application running on a separate machine, it provides 
close to real-time backup for multiple NetBackup Servers. So even if one of the NetBackup 
Server failed, the RPS still has a copy of the backup data.   
 
The relationships of the NetBackup Suite are depicted in the diagram below. 
 

 
 
^Back to top 
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2. NetBackup Manager 

2.1. What is the recommended bandwidth? 

It really depends on what kind of data to be backed up, e.g. for personal file backups, the 
daily data transfer should be limited, while MS Exchange backup could be significant. You 
may want to use the following white paper as a reference: 
 
http://www.NetAccess.com/en/doc/white-paper-backup-speed.pdf. 
 
^Back to top 

2.2. How do I run NetBackup Manager with Microsoft ISA 2004? 

To connect NetBackup Manager to NetBackup Server through Microsoft ISA Server, please do 
the following to enable [Web Proxy] service on the ISA Server: 

1. Open [Start] -> [Programs] -> [Microsoft ISA Server] -> [ISA Server Management] 

2. On the left panel, select [Microsoft Internet Security and Acceleration Server] -> 
[SERVER] -> [Configuration] -> [Networks] 

3. On the top menu, select [Action] -> [New] -> [Network]. Enter a “Network Name” 
(e.g. Internal) and define the IP address range for your internal network  
(e.g. 192.168.1.0 - 192.168.1.255) 

4. Double click the new network that should now be added to on the bottom panel 

5. Select the [Web Proxy] tab  

6. Check both [Enable Web Proxy clients] and [Enable HTTP] checkboxes and choose a 
[HTTP port] for the web proxy service 

7. (Optional) Press the [Authentication] button, check the [Basic] checkbox and the 
[Require all users to authenticate] checkboxes if you want to enable and enforce 
proxy authentication 

8. Press the [OK] button to make the changes and press the [Apply] button to apply the 
changes 

9. Open [NetBackup Manager] from the system tray and press the [Options] button 

10. In the [Proxy Seting] section, select the [Proxy] radio button 

11. Enter the hostname/IP address of the ISA server in the [Proxy Address] text field and 
the TCP port for web proxy service on your ISA Server in the [Port] text field 

12. Press the [OK] button to connect to the server  

 
If you run into any problems connecting to the NetBackup Server from NetBackup Manager 
using ISA Server, please do the following to check if your request is being blocked: 

1. On the left panel of [ISA Server Management], select [Microsoft Internet Security 
and Acceleration Server] -> [SERVER] -> [Monitoring]  

2. Then select the [Logging] tab that appears on the right panel3. Click the [Edit Filter] 
link and create a filter with the following values: 

 [Log Record Type] equals [Web Proxy Filter] 

 [Destination IP] equals [The IP address of NetAccess Offsite Backup Server] 

3. Press the [Start Query] button 

4. Open [NetAccessOnline Backup Manager] again and try connecting to the NetBackup 
Server using the same procedure above.  

 
Check if there are any errors generated in the log table. 
 

^Back to top 

2.3. How do I install NetBackup Manager on FreeBSD? 

You can either run NetBackup Manager on a Linux version of Sun Java JDK (performance 
might not be optimized) or on a FreeBSD native Java SDK. 
 
Please do the following for the Linux version of Sun Java JDK option: 

http://www.ahsay.com/en/doc/white-paper-backup-speed.pdf
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1. Install Linux binary compatible port to the FreeBSD machine 

2. Install the Linux version of Sun Java 1.4.2 or above JDK onto the FreeBSD machine 

3. Create a symbolic link from $OBM_HOME/jvm to $JAVA_HOME (installed in previous 
step) 

4. Run $OBM_HOME/bin/RunBackupSet.sh [BACKUP_SET_NAME] to run your backup 

5. Run $OBM_HOME/bin/Scheduler.sh to start the backup scheduler 

 
Please do the following for the FreeBSD native Java SDK option: 

1. Install Linux binary compatible port to the FreeBSD machine 

2. Install the Linux version of Sun Java 1.4.2 or above JDK onto the FreeBSD machine 

3. Compile the FreeBSD native Java 1.4.2 SDK using the JDK compiler installed in the 
previous step 

4. Install the FreeBSD native Java 1.4.2 SDK onto the FreeBSD machine 

5. Create a symbolic link from $OBM_HOME/jvm to $JAVA_HOME (installed in previous 
step) 

6. Run $OBM_HOME/bin/RunBackupSet.sh [BACKUP_SET_NAME] to run your backup 

7. Run $OBM_HOME/bin/Scheduler.sh to start the backup scheduler  

 
^Back to top 

2.4. How do I install NetBackup Manager on SCO Unix? 

Please do the followings to install OBM on SCO: 

1. Install Java 1.4.x or above onto your SCO Unix box 

2. Download obm-linux.tar.gz and expand it to $OBM_HOME (e.g. /usr/local/obm) 

3. Delete $OBM_HOME/jvm and create a symbolic link from $OBM_HOME/jvm to the 
SCO Unix Java VM 

4. Run $OBM_HOME/bin/BackupManager.sh to setup your backup set (or run 
$OBM_HOME/bin/Configurator.sh if you are under command line mode. Then use the 
OBS Management Console to setup your backup sources and other settings) 

5. Run $OBM_HOME/bin/RunBackupSet.sh [BACKUP_SET_NAME] to run your backup 

6. Run $OBM_HOME/bin/Scheduler.sh to start the backup scheduler 

 
^Back to top 

2.5. How do I install NetBackup Manager on AIX? 

Please do the followings to install NetBackup Manager on AIX: 

1. Install Java 1.4.x or above (Java 1.4.2 or above recommended) onto your AIX box 

2. Download obm-linux.tar.gz and expand it to $OBM_HOME (e.g. /usr/local/obm) 

3. Delete $OBM_HOME/jvm and create a symbolic link from $OBM_HOME/jvm to the 
AIX Java VM 

4. Run $OBM_HOME/bin/BackupManager.sh to setup your backup set (or run 
$OBM_HOME/bin/Configurator.sh if you are under command line mode. Then use the 
web interface to setup your backup sources and other settings) 

5. Run $OBM_HOME/bin/RunBackupSet.sh [BACKUP_SET_NAME] to run your backup 

6. Run $OBM_HOME/bin/Scheduler.sh to start the backup scheduler 

 
^Back to top 

2.6. The Windows version of NetBackup Manager installer hangs, what 
could be the problem? 

There are few things that could create errors during or after executing the installer. 

1. Make sure there is enough disk space on the machine. 

2. Make sure you do not have any anti virus software or PCanywhere running, as this 
may create problems with InstallAnywhere installers.  
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3. There are also problems with InstallAnywhere installers and Dell OpenManager. If 
OpenManager has installed on the target system, be sure to disable it before 
installing NetBackup Manager. 

4. Hardware could cause errors as well, try set your [hardware acceleration display 
setting] to off. There are problems with certain versions of Java running along with 
certain video cards. 

5. This may only be a Java problem. 

Also, if you are transferring this file from one machine to another, please be sure the file size 
is valid and you are transferring the file in binary mode. 
 
Java Testing 

Please try running any of the Swing demos that came with the Java runtime in 1.4.X and see 
if it hangs on Windows. In order to fix this problem, some knowledge base on the Internet 
suggested updating DirectX to at least DirectX 8.1. Most machines got this problem had 
DirectX 7.0 installed. (You can use the “dxdiag” command to find out the directX version) 

SUN recommended two workarounds for certain video card issues 

1. The following will pass properties to the installer's Virtual Machine: 
In Advanced Designer – Project -> Config -> Additional Arguments 
set that to "-Dsun.java2d.d3d=false -Dsun.java2d.noddraw=true" without the 
quotes. 

2. Set the following lax property in your LaunchAnywhere for your application's JVM:  
lax.nl.java.option.additional=-Dsun.java2d.d3d=false -Dsun.java2d.noddraw=true 
 
Add the same line to the uninstaller lax file, using a modify file action in your installer 
in post-install. 

 

^Back to top 

2.7. The Installer doesn‟t seem to work. How can I manually install 
NetBackup Manager on Windows? 

To manually install NetBackup Manager on Windows, you‟ll need to copy and zipping the 
program directory (e.g. C:\Program Files\NetBackup Manager) from another machine with 
NetBackup Manager installed. Then do the followings on the machine you wish to manually 
install:  

1. Create the directory C:\Program Files\NetBackup Manager 

2. Unzip the NetBackup Manager program directory archive to C:\Program 
Files\NetBackup Manager 

3. Run C:\Program Files\NetBackup Manager\bin\install.bat 

4. Run C:\Program Files\NetBackup Manager\bin\Install-Scheduler.bat 

 
^Back to top 

2.8. The Installer doesn‟t seem to work. How can I manually install 
NetBackup Manager on Mac? 

Try manually installing NetBackup Manager on your Mac with the following instructions: 

1. Download NetBackup Manager from the http://www.NetAccess.com. 

2. Expand obc-mac.zip into /Applications/OBM 

3. Run "chmod -R 755 /Applications/OBM" using Terminal 

4. Double-click the “NetBackup Manager” icon in /Applications/OBM folder 

 
^Back to top 

2.9. Error occurred when Installing NetBackup Manager on Novell. 

Some users would have problems when trying to install NetBackup Manager on Novell 
Netware Client version. (The machine had met all the system requirements: Netware v5.1 
and Netware Java v1.3.1). User could receive the following error message during 
installation. 
 

http://www.ahsay.com/
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Exception in thread "main" 
Java.lang.noclass def found error.obm 
Java: class obm exited with status 1 

 
Check the following 

Please check if the OBM_HOME environment variable set in 
SYS:\OBM\bin\BackupManager.ncf is correct? 

 

envset OBM_HOME=SYS:\OBM 

envset OBM_CLASSPATH=$OBM_HOME\bin;$OBM_HOME\bin\obm.jar; 
$OBM_HOME\bin\obm-lib.jar 

envset LIB_PATH=$OBM_HOME\bin 

java -mx384m -Djava.library.path=$LIB_PATH -cp $OBM_CLASSPATH obm SYS:\OBM 

 

Please change the SYS:\OBM environment variable to your installation directory. 

 
^Back to top 

2.10. Are there any command line tools for NetBackup Manager? 

Yes, there are scripts in [OBM Program Home]\bin and they are described below: 
 
Windows 

 Decrypt.bat: decrypts the specified backup files 

 install.bat: installs the NetBackup Manager icon to the System Tray and registers the 
NetBackup Scheduler as a service 

 Install-Scheduler.bat: registers the NetBackup Scheduler as a service 

 RegisterVSS.bat: re-registers Microsoft‟s Volume Shadow Copy service DLLs 

 Remove-Scheduler.bat: un-registers the NetBackup Scheduler service 

 Restore.bat: restores the specified snapshot of the backup set to the specified 

location 

 RunBackupSet.bat: runs the specified backup set 

 RunOBM.bat: launches the NetBackup Manager user interface 

 Run-Scheduler.bat: starts the NetBackup Scheduler service 

 SeedLoad.bat: runs seed load for the specified backup set to the specified location 

 Uninstall.bat: removes the NetBackup Manager icon from the System Tray and 
un-registers the NetBackup Scheduler service 

Linux 

 BackupManager.sh: launches the NetBackup Manager user interface 

 Configurator.sh: configures client parameters such as Backup Server address, 
username/password, encrypting key, etc. 

 Decrypt.sh: decrypts the specified backup files 

 Restore.sh: restores the specified snapshot of the backup set to the specified location 

 RunBackupSet.sh: runs the specified backup set 

 Scheduler.sh: starts the NetBackup Scheduler service 

 SeedLoad.sh: runs seed load for the specified backup set to the specified location 

 StopScheduler.sh: stops the NetBackup Scheduler service 

 

*You may have to set some variables in these scripts and more instructions are provided. 

 
^Back to top 
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2.11. How does NetBackup Manager detect changes in files? Does it use 
the Archive bit? Some tape backup software resets the Archive bit. 
Would this affect NetBackup Manager when backing up the same 
data? 

NetBackup Manager compares timestamps of files on the server with the corresponding 
copies on client machine. Archive bit is not used as it does not detect relocated files. 
Therefore tape backup would not affect NetBackup Manager.  
 
^Back to top 

2.12. Does NetBackup Manager copy the same set of files regularly? 

After the initial upload, subsequent backup jobs will only transfer the modified or new data to 
the Backup server. It depends on the nature of the data, but normally, less than 2% of all 
data is modified.  
 
^Back to top 

2.13. Transfer Block Size is 128Kb by default. Is there a reason for this? 

Backup data is transferred in blocks (instead of file by file) to minimize connection 
negotiation roundtrips. It is not the TCP/IP block size. This setting is optimal for the backup 
operation. 
 
^Back to top 

2.14. How can I backup a huge data set over the Internet? 

If you have a lot of data (e.g. 300GB) to backup to the Backup server, it would take a 
considerable amount of time to perform the first full backup over the Internet. You can try the 
following method:  

1. Use the Seed Loading Utility to backup your backup set to a local hard disk (instead 
of directly transfer to the Backup server)  

2. Send the backup data, using a removable hard disk, to your backup service provider.  

3. The administrator can then load all your backup files from your removable hard disk 
into your backup account. This could save you days (even weeks) of performing your 
first full backup.  

In addition, subsequent backups are incremental (only new or updated files will be uploaded 
to the server), the amount of data transfer should be relatively small.  
 
Please refer to the User‟s Guide for details on the “Seed Loading Utility”. 
 

^Back to top 

2.15. What is the best way to restore a huge data set? 

You can copy the data of the particular backup set on NetBackup Server to a removable 
media, e.g. external hard disk, and ship it to your client. Your client can then use the “Decypt 
Files Tool” in NetBackup Manager to restore the backup data from the removable media to 
its original format. 
 
^Back to top 

2.16. Does In-File Delta backup require a temporary working directory?  

NetBackup Manager requires a temporary storage for the delta file before it gets sent to the 
server.  

For example:  

If you have a 10GB file that has already been backed up to the server and you have 
updated 10MB of this file. Then you need to have at least 10MB of free space in the 
temporary directory for the delta file.  
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*Note: Certainly you do not need 10GB of free disk space.  

Also, if you want to backup 5 x 10GB files in the same situation. You will only need 10MB of 
free space (not 5 x 10MB), because each delta file will be automatically deleted right after it 
has been backed up.  

 
^Back to top 

2.17. What is the average compression ratio? 

All backup files are compressed and encrypted before uploading to the Backup Server, the 
average compression ratio for text-based file is around 4:1. However, no further 
compression can be made on files that are already in compressed format (e.g. JPG, ZIP). In 
general, you can assume a 2:1 compression ratio when you are backing up a file set with 
variety types. 
 
^Back to top 

2.18. Can I change my encrypting key? 

The encrypting key cannot be changed once you setup your Backup Set. This is necessary for 
the integrity of the Backup Set, making sure that backup data is only encrypted by one key. 
Otherwise, you will have problems remember two encrypting keys when you want to restore 
your files in the future. 
 
You need to recreate your Backup Set if you really want to change your encrypting key.  
 
^Back to top 

2.19. If the “Use Login Password as Encrypting Key” option was 
selected when creating the backup set. Why I cannot restore the 
backup data with my most current login password? 

By selecting the “User Login Password as Encrypting Key” option when creating a backup set, 
NetBackup Manager will set your login password as the encrypting key for the backup set. 
Once set, even if you change your login password afterward, the encrypting key will remain 
as your original password. In other words, if you have changed your login password, you still 
need to use the original password to decrypt and restore the backup set. 
 
Currently, if the encrypting key is forgotten or lost, the backup set can never be restored. It 
is not possible to restore without the key. 
 
You can find out the encrypting key from the corresponding NetBackup Manager, please refer 
to http://download.NetAccess.com/support/screenshots/EncryptingKey.jpg  
 
^Back to top 

2.20. What kind of encryption used by NetBackup Manager? 

There are two encryptions being performed by NetBackup Manager: 

 

1. Encryption of backup data - This is being done by 128-bit symmetric key 
encryption (AES, TripleDES, TwoFish). 256-bit is not available because it requires too 
much CPU and it is not really required. (128-bit is currently being used by most 
banks) 

2. Encryption of backup traffic - This is being done by 1024 bit RSA public key 
encryption. The strength of the encryption depends on the key size you use when you 
generate your CSR before submitting to your CA. 1024 bit is what is being used by 
most CAs. 

 
^Back to top 

http://download.ahsay.com/support/screenshots/EncryptingKey.jpg


 

 NetBackup 

Technical FAQ 

 

NetAccess Systems Inc. Page 11 of 26 (October 7, 2009) 

 

2.21. When select the backup option “local hard drive” to backup to 
external hard drive, it fails in the middle of the process, why? 

Please check if the external hard drive is in FAT32 volume format. And also check whether 
there is any folder containing more than 32000 files and there is no file bigger than 4GB 
within your backup set. It is a FAT32 limitation, you may try to convert the FAT32 volume to 
NTFS.   
 
^Back to top 

2.22. Scheduled backup jobs are not running on my Windows machine, 
why? 

Please try the followings: 
 

1. Check if [Control Panel] -> [Administrative Tools] -> [Services] -> [Online Backup 
Scheduler] is available and started 

2. Check if C:\Program Files\NetBackup Manager\home.txt contains the home directory 
for your backup account (e.g. C:\Documents and Settings\Administrator\.obm) 

3. Check if C:\Program Files\NetBackup Manager\jvm\bin\SchedulerOBM.exe exists 

4. Check if C:\Program Files\NetBackup Manager\log\Scheduler\info.log contains the 
startup loading entry, e.g. 

i. [2005/12/12 12:42:44] OS Name=Windows XP 

ii. [2005/12/12 12:42:44] OS Version=5.1 

iii. [2005/12/12 12:42:44] Scheduler Version=5.0.1.3e 

iv. [2005/12/12 12:42:44] Java Vendor=Sun Microsystems Inc. Version=1.4.2_10 

v. [2005/12/12 12:42:44] [info] Starting Scheduler, User:'backup-account', 
Home:'C:\Documents and Settings\Administrator\.obm' 

5. Check if C:\Documents and Settings\Administrator\.obm\log\Scheduler\debug.log 
contains the debugging information for your scheduler 

 
If your system settings is not the same as the above steps, please download a new installer 
(obc-win.exe) from our website or the customization portal and try again. 
 
^Back to top 

2.23. I am having problems with my scheduled backup, why? 

If you are backing up files from a network drive, please check if you have included the valid 

“Network Resources Authentication” information for the backup set. This is required for 
scheduled backups that access any network resources.  

You can refer to the following screenshot: 

http://download.NetAccess.com/support/screenshots/Network_Resources_Authentication.
JPG  

 
^Back to top 

2.24. I cannot get proxy authentication to work with NetBackup Manager, 
why? 

If you are using port 80, please check whether your proxy server accepts "HTTP CONNECT" 
calls on port 80. You may also want to try other ports like 443 to see if your proxy server 
accepts that. 
 
^Back to top 

2.25. Can I backup an entire Operating System? 

Currently, it is not possible to do hard disk image backup with NetBackup Manager. However, 
you can still backup/restore the operating system by doing the followings: 
 

http://download.ahsay.com/support/screenshots/Network_Resources_Authentication.JPG
http://download.ahsay.com/support/screenshots/Network_Resources_Authentication.JPG
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To backup all files including the operating system, please do this: 

1. Add all files to your backup source 

2. Add a SystemState backup type to your backup account (Windows only) 

 
To restore all files including the operating system, please do this: 

1. Re-install the operating system and applications 

2. Restore the SystemState backup to your machine (Windows only) 
- To restore the System State data on a domain controller, you must first start your 
computer in a special startup option called "Directory Services Restore Mode". To 
access "Directory Services Restore Mode", press F8 during startup and select it from 
the list of startup options. 

3. Restore all files to your machine 

 
^Back to top 

2.26. When setting up a Microsoft SQL Backup Set, I cannot list the 
available SQL servers, what can I do? 

You can try running “osql –L” in a command prompt, you should see the following: 
 
Servers: 
    (local) 
    SQLSERVER1\INSTANCE1 
    SQLSERVER2\INSTANCE2 
 
If you have a firewall installed, please disable it. UDP Broadcast must be allowed. 
 
^Back to top 

2.27. Why are the Microsoft SQL Server databases missing from the 
backup source list?  

If you have firewall installed on your network, please make sure UDP port 1434 is allowed on 
the SQL Server.  
 
^Back to top 

2.28. How to set the recovery model of a MS SQL database to FULL? 

You can change the recovery model by running the following commands, run it along with 

each of the database that you want to run transaction log backup. 

C:\> osql -E -S SQLSERVER1\INSTANCE1 -Q "ALTER DATABASE xxx SET RECOVERY FULL" 

    Where 

SQLSERVER1\INSTANCE1 = the SQL Server and the corresponding instance 

xxx = the name of the database 

 
^Back to top 

2.29. Windows network map drive connections are not stable, why? 

You may want to try editing a few Windows Parameters. 
 

SMB Size 

When running applications that copy or move a large amount of data to a remote server, the 
speed of such action is determined by network speed and by the SMB (a protocal related to 
Windows map drive) size.  

NT/2000 negotiates the SMB size and will generally set this to 4K blocks for applications that 
are moving or copying data to a remote server. By increasing this block size, you will allow 
the server to complete its file copies faster. This will increase the performance of the 
application making the copy/move calls. 
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HKEY_LOCAL_MACHINE\System\Current Control Set\Services\LanmanServer\Paramerters 

 

"SizReqBuf"= REG_DWORD 

Set Value To: 16000 = HEXDEC 

Ref: http://support.microsoft.com/default.aspx?scid=kb;en-us;320829 

     

Map Drive Auto Disconnect Settings 

Reference: http://support.microsoft.com/kb/138365/EN-US/ 

http://support.microsoft.com/default.aspx?scid=kb;en-us;297684  

 

HKEY_LOCAL_MACHINE\System\Current Control Set\Services\LanmanServer\Paramerters 

 

Autodisconnect to: fffffff 

 

Creating BAT file for better performance 

If you are still having problems, you may want setup a BAT file and scheduled this file to run 
every 10 minutes, please setup the BAT file as follow: 

BAT file settings: 
-------------------------- 

ping mapdrv 
ping 192.168.1.15 
net config server /autodisconnect:-1 
net use /persistent:yes 
net use "\\mapdrv\DATA STORAGE1" 
net use "\\192.168.1.15\DATA 
net use d: \\192.168.1.15\DATA STORAGE1 

net use e: "\\mapdrv\DATA STORAGE1" 
dir d:\  
dir e:\  

-------------------------- 

 mapdrv = your NAS device network name 

 192.168.1.15 = mapdrv 

 
In addition, create a host file on the server hosting the program, have the following entry in 
it:  
 mapdrv = 192.168.1.15 

 
And if you are on a 2003 server, refer to the following: 
Reference: http://support.microsoft.com/default.aspx?scid=kb;en-us;890553  
 
For Windows 2000, you may want to install the following Hotfix: 
Windows2000-KB903237-x86-ENU 
Reference: http://support.microsoft.com/default.aspx?scid=kb;en-us;903237  
 
^Back to top 

2.30. There is an error when backing up files on a remote NetWare 
server, what can I do? 

If you want to backup \\SERVER\SHARE that is located on a NetWare server and you are 
getting "Network drive is not accessible" error message. Please try adding the following 
command as a [Pre-backup command]  
 
net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAME]\[USERNAME] 
 
This will authenticate the current process with the NetWare server and therefore allow your 
backup to run correctly. 
 
^Back to top 

http://support.microsoft.com/default.aspx?scid=kb;en-us;320829
http://support.microsoft.com/kb/138365/EN-US/
http://support.microsoft.com/default.aspx?scid=kb;en-us;297684
http://support.microsoft.com/default.aspx?scid=kb;en-us;890553
http://support.microsoft.com/default.aspx?scid=kb;en-us;903237
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2.31. What are the advantages and disadvantages of backing up multiple 
computers using a single backup account?  

Advantages 

 You require less backup accounts 

 You can use one username and password to configure the backup setting for all 
Backup Sets 

Disadvantages 

 You must use different backup sets for different computers 

 Whenever a new backup set is created under the backup account, you need to go 
back to all computers using the same backup account to uncheck the “Run 
scheduled backup on this computer” option for the new backup set (Since backup 
setting is saved on server and new backup set is default to run on all computers, i.e. 
with the option checked). 

 Improper configuration could easily cause problems, which are difficult to debug. 

 
^Back to top 

2.32. How to find out which version of the client software the user is 
using?  

You can check which version a client is running by checking the access log.  
The default location of the access log file is: 

 Windows: “C:\Program Files\NetAccess Offsite Backup Server\logs\access_log*.txt” 

 Linux: “/usr/local/obs/logs/access_log*.txt” 

 Mac OS X: “/Applications/OBS/localhost/logs/access_log*.txt”  

The „/obs/obcX.X/file/????File.obc?u=USER_NAME&..ver=Y.Y‟ entries contain this 
information, where:  

 USER_NAME = Login Name of a backup account  

 X.X = major version of the client software 

 Y.Y = minor version of the client software 

 
And starting from NetBackup Server v5.0.1.5, the version of OBM can be check from the 
NetBackup Server Management Console under the [Manager User] -> [Report] -> [Detailed 
Report] page of the corresponding user. 

 
^Back to top 

2.33. Does the NetBackup Manager upgrade the installation of Java on a 
client machine, or does it install a separate copy for its own use?  

NetBackup Manager uses its own copy of Java and leaves the system Java VM intact. 
 
^Back to top 

2.34. After upgrading NetBackup Server, do I have to upgrade all the 
NetBackup Manager as well? And do I need to transform/migrate 
their current data? 

NetBackup Server works with previous versions of NetBackup Manager (However not the 
other way round). You only need to upgrade the existing client software if you want to take 
advantage of the new features. And you do not need to transfer client backup data again after 
the NetBackup Server ugprade. 
 
^Back to top 
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2.35. Is it possible to do incremental or differential backups with 
MySQL? 

MySQL backup is done with SQL Dump file, and it generates a single file which is then 
uploaded. These backup files usually very large size and it takes time to backup to the server. 
At this moment, it is not possible to do incremental dump with mysqldump. But our In-File 
Delta feature shall ensure that, instead of the entire backup file, only the changed data blocks 
within the dump file are uploaded to the Backup Server.  
 
^Back to top 

2.36. How does the “Remove retention files for overlap policy” under 
Advanced Retention Policy work? 

In general, daily snapshots followed by a weekly snapshot or a monthly snapshot, etc. will be 
removed; weekly snapshots followed by a monthly snapshot or a quarterly snapshot, etc. will 
be removed; and so on.  
 

This is illustrated by the following example. 

Assume today is 17Jan06, and the Advanced Retention Policy is as follows:  

 Daily: retain for 7 days 

 Weekly: retain for 4 weeks (the job will be performed on Saturday) 

 Monthly: retain for 3 months (the job will be performed on 1st of each month) 

If “Remove retention files for overlap policy” is NOT enabled: 

Then a total of 14 snapshots (7+4+3) will be kept on the server accordingly, i.e.:  

(Daily): 10Jan06, 11Jan06, 12Jan06, 13Jan06, 14Jan06, 15Jan06, 16Jan06 
(Weekly): 24Dec05, 31Dec05, 7Jan06, 14Jan06 
(Monthly): 1Nov05, 1Dec05, 1Jan06 

If “Remove retention files for overlap policy” is enabled: 

Then only the following snapshots are kept: 1Nov05, 1Dec05, 1Jan06, 14Jan06, 15Jan06, 
16Jan06.  

 
Specifically, the weekly policy overrides the daily policy so 10Jan06, 11Jan06, 12Jan06 and 
13Jan06 will be removed. The monthly policy overrides the weekly policy, and 24Dec05, 
31Dec05 and 7Jan06 will be removed as well. 

 
^Back to top 

2.37. What is incremental backup and how does In-File Delta work? 

In an incremental backup, only modified files will be uploaded to the Backup Server.  
 
On the other hand, In-File Delta is applicable to the physical files to be uploaded to the 
Backup Server, does not matter whether it is a MS SQL database file, MS Exchange 
transaction log file or any normal file in a FileBackupSet. Specifically, only the changed blocks 
in comparison to the original file on the Backup Server (delta file) will be uploaded. 
 
For each modified file, NetBackup Manager would determine whether the entire file or only 
delta file should be uploaded. If the entire file is to be uploaded, the old version of the file will 
be moved to the Retention area. Else if only the delta file is to be uploaded, the previous delta 
files will be moved to the Retention area and the Data area should contain the original full 
backup file, checksum file and the latest delta file of this file.  
 
^Back to top 

2.38. How does the “Auto” block size work under In-file Delta settings? 

If the block size is set to “Auto”, the effective block size (Started from OBM v5.0.1.7) will be 
chosen from the following table based on the file size of the updated file: 
 
 File Size   Delta Block Size 
 ------------  ---------------- 
 0 - 500M      4k 
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 500M - 2G     8k 
 2G - 8G       16k 
 8G - 15G      32k 
 > 15G         64k 
 
^Back to top 

2.39. What happens when we do In-File Delta backup on a directory? 

When you do backup, the NetBackup software will do the followings: 

1. Check if any files are added, updated or deleted (the calculation of these files are 
based on files having the same filename). 

2. New files will be uploaded to the server in whole. 

3. Deleted files will be removed from Data area and placed into the Retention area on 
the Backup server. 

4. Updated files will be processed by the In-File delta option (i.e. only changed data 
blocks within the files will be uploaded to the Backup Server) 

 
^Back to top 

2.40. Does NetBackup Manager have to stop the application when doing 
online backups? 

NetBackup Manager can backup application data while the application is still running. 
Particularly, we have special agents for MS Exchange Server, MS SQL Server, Oracle, Lotus 
Notes and MySQL, which allows these applications to be backed up while they are online. 
With the Volume Shadow Copy feature started from NetBackup Manager v5.0, we are able 
to backup other types of applications while they are online. 
 
^Back to top 

2.41. What are Off-line backup, Logout backup reminder and Local 
backup features? 

Off-line Backup is basically designed for notebook users who are off-line most of the time, 
and cannot rely on backup schedule to backup regularly. The backup interval allows notebook 
users to specify the interval that they would like their data to backup. If this interval has 
elapsed, backup will run automatically once this machine is online. 
 
Logout Backup Reminder asks user if they would like to backup if they logout of the 

computer or shutdown their computer. 
 
Local Backup allows an extra copy of backup file to be kept on local hard disk when backup 
is running. 
 
^Back to top 

2.42. Why is my NetBackup Manager running backup once every hour? 

You might have “Off-line backup” enabled for every hour. Please do the following to disable 
that:  

1. Logon to OBM  

2. Select the backup set that you want to disable the Off-line backup from the left panel 

3. Select the [Extra Backup] node under the backup set node on the left panel 

4. Uncheck the [Enable off-line backup] checkbox under the “Off-line Backup” section 

5. If you want to do this to all backup sets, please repeat the previous step for each 
backup set 

Press the [Save Setting] button from the toolbar 
 

^Back to top 
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2.43. How do I disable “logout backup reminder”? 

To disable the “System Logout Backup Reminder”, please do the followings: 

1. Logon to NetBackup Manager  

2. Select the backup set that you want to disable the Logout reminder from the left 
panel 

3. Select the [Extra Backup] node under the backup set node on the left panel 

4. Uncheck the [Enable System Logout Backup Reminder] checkbox under the “System 
Logout Backup Reminder (Windows)” section 

5. If you want to do this to all backup sets, please repeat the previous step for each 
backup set 

Press the [Save Setting] button from the toolbar 

 
^Back to top 

2.44. How do I upgrade NetBackup Manager from V4.5 on Linux? 

Please do the followings for upgrade: 

1. Shutdown backup scheduler by running "touch $OBM_HOME/ipc/Scheduler/stop" 

2. Make this directory ~/.obm 

3. Move old $OBM_HOME/log and $OBM_HOME/config to ~/.obm  

4. Rename $OBM_HOME to $OBM_HOME.bak 

5. Install new OBM to $OBM_HOME and expanding all files into $OBM_HOME 

6. Run $OBM_HOME/bin/BackupManager.sh (or $OBM_HOME/bin/Configurator.sh if in 
command line mode) to configure your backup set. All your old setting should still be 
there. 

7. Run $OBM_HOME/bin/Scheduler.sh to startup backup scheduler (you must have run 
$OBM_HOME/bin/BackupManager.sh or $OBM_HOME/bin/Configurator.sh once, 
before starting up the scheduler) 

 
^Back to top 

2.45. How do I change the .obm path for Novell?  

Please take a look at SYS:\OBM\home.txt. It contains the path to the .obm directory. You can 
do the followings to make the changes: 

1. Stop the scheduler  

2. Change the entry in SYS:\OBM\home.txt to another directory  

3. Copy the .obm directory from existing location to new location 

4. Startup the scheduler again 

5. Also, open “SYS:\OBM\bin\BackupManager.ncf” and append the updated .obm path 
to the end of the whole command line. 

Example 

java -mx384m -Djava.library.path=$LIB_PATH -cp $OBM_CLASSPATH obm 
SYS:\OBM C:\[new location]\.obm 

 
^Back to top 

2.46. The MS SQL or MS Exchange database backup job stores 2 copies 
of the spooled database file in the "temporary directory" (tagged 
with different datetimes). This has taken up extra disk space, is this 
necessary?  

If you have interrupted any of the backup jobs, the file tagged with the datetime of the 
corresponding backup job will be renamed to its original filename just before it is uploaded. 
This is necessary as we need to ensure that the snapshot of different dates would not 
overwrite each other. 
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If a backup job is still running, just let it runs to completion. If backup has been stopped 
already, just remove all files tagged with the corresponding datetime in the “temporary 
directory” and try to perform a full database backup again. 
 
^Back to top 

2.47. What do I have to do in order to backup open files? 

You need to be on NetBackup Manager v5.0 or above, as well as support from the underlying 
OS. Windows XP and 2003, by default, come with Volume Shadow Copy, which allows 
backup open file. For older platforms, e.g. Windows 9x/ME/NT/2000 or NetWare, we would 
recommend adding a third party open file manager option (e.g. St. Bernard Open File 
Manager - http://www.stbernard.com/) which might cost around US$100 for each 
workstation and US$300 for each server if open file backup is required. 
 
*Open file option is not required on Linux/Unix/Mac OS X because no files are held exclusively open by 

applications. 

 
^Back to top 

2.48. How does Volume Shadow Copy work? 

Please refer to: 
http://technet2.microsoft.com/WindowsServer/en/Library/2b0d2457-b7d8-42c3-b6c9-59c
145b7765f1033.mspx  
 
^Back to top 

2.49. In Windows, when NetBackup Manager is creating Shadow Copy 
Set, it gets the “[ERROR] E_UNEXPECTED” error, what can I do? 

This is a Microsoft Volume Shadow Copy issue. Microsoft's recommendation is to try 
re-registering the Volume Shadow Copy Service. If you are on Win XP Pro, you can simply run 
the batch file available in C:\Program Files\OBM\bin\RegisterVSS.bat or 

http://download.NetAccess.com/support/RegisterVSS.bat.  

 
^Back to top 

2.50. How to backup Oracle 7.3.4 on NetWare? 

To backup Oracle 7.3.4 on NetWare 5.1, it is not possible to use the Oracle agent, you need 
to do the followings: 

1. Backup all Oracle 7.3.4 datafiles, control files, and pfile. 

2. Use "exp" (export utility) to dump Oracle database to a dump file (make this a 
pre-backup command) 

3. Use NetBackup Manager to backup this file 

 
When you need to restore the database, just restore all datafiles, control files, pfile to its 
original location and use "imp" (import utility) to put the data back into Oracle database. 
 
^Back to top 

2.51. How do I backup NTFS permission? 

For version 5.1 or later, NTFS permission is also backed up during the backup operation. For 
other versions, please do the followings: 

1. Download and install 

http://www.microsoft.com/downloads/details.aspx?FamilyID=E8BA3E56-D8FE-4A9
1-93CF-ED6985E3927B&displaylang=en  

2. Add a pre-backup command to dump the NTFS permissions of all files you want to 
backup into a dump file. For example, if you want to have all files under C:\ drive to 
a C:\NTFS-Permission.txt, please add: 
 

http://www.stbernard.com/
http://technet2.microsoft.com/WindowsServer/en/Library/2b0d2457-b7d8-42c3-b6c9-59c145b7765f1033.mspx
http://technet2.microsoft.com/WindowsServer/en/Library/2b0d2457-b7d8-42c3-b6c9-59c145b7765f1033.mspx
http://download.ahsay.com/support/RegisterVSS.bat
http://www.microsoft.com/downloads/details.aspx?FamilyID=E8BA3E56-D8FE-4A91-93CF-ED6985E3927B&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=E8BA3E56-D8FE-4A91-93CF-ED6985E3927B&displaylang=en
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"C:\Program Files\Windows Resource Kits\Tools\subinacl" /noverbose 
/outputlog=C:\NTFS-Permission.txt /subdirectories C:\*.* /display 
 
to your pre-backup command. 

3. Add "C:\NTFS-Permission.txt" to the [Backup Source] of this backup set 

 
^Back to top 

2.52. How do I restore NTFS permission? 

For version 5.1 or later, the backed up NTFS permission will be restored automatically. For 
other versions, assuming the NTFS Permission is being stored in "C:\NTFS-Permission.txt", 
please do the followings: 

1. Restore "C:\NTFS-Permission.txt" from the backup server using OBM 

2. Apply all NTFS permissions backup to all your backup files by running:  
 
"C:\Program Files\Windows Resource Kits\Tools\subinacl" /playfile 
C:\NTFS-Permission.txt 

 
^Back to top 

2.53. How do I backup file permission in Linux? 

For version 5.1 or later, Linux file permission is also backed up during the backup operation. 
For other versions, please do the followings: 
 

1. Add a pre-backup command to dump the Access Control Lists of all files you want to 
backup into a dump file. For example, if you want to have all files under /home to a 
/ACL.txt, please add: 
 
   cd /; getfacl -R home > ACL.txt  
 
to your pre-backup command. 

2. Add "/ACL.txt" to the [Backup Source] of this backup set 

 
^Back to top 

2.54. How do I restore file permission in Linux? 

For version 5.1 or later, the backed up Linux file permission will be restored automatically. 
For other versions, assuming the Access Control Lists is being stored in "/ACL.txt", please do 
the followings: 

1. Restore "/ACL.txt" from the backup server using NetBackup Manager 

2. Apply all Access Control Lists backup to all your backup files by running  
 
   cd /; setfacl --restore=ACL.txt 

 
^Back to top 

2.55. How do I remove NetBackup Manager completely from my 
Windows machine? 

If you want to completely remove NetBackup Manager from Windows, after uninstalling the 
software from [Control Panel] -> [Add or Remove Programs], please do the followings: 

 Ensure that the NetBackup Manager installation directory is deleted (sometimes not 
removed when Windows somehow holds some of the files) 

 Remove the C:\Documents and Settings\administrator\.obm\ folder (intentionally 
left undeleted, as important information of the user and backup sets, such as the 
encryption keys, are stored here) 

 
^Back to top 
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2.56. Does NetBackup Manager work with dial-up connections? 

It makes no difference to NetBackup Manager if the connection is always on or dial-up.  
 
If you want Windows to connect to the ISP automatically when a backup starts, you can go to 
[Control Panel] -> [Internet Options] -> [Connections] and select “Always dial my default 
connection”.  

 

^Back to top 

2.57. The NetBackup Manager crashes when opening [Backup Source] 
of a Lotus Domino/Notes backup set, what can I do? 

Check to see if you can find a hs_err_pid????.log file under the [OBM Home], and if it contains 
the error "Unable to complete restart processing, err = Recovery Manager: Error from 
Logging Subsystem", please do the followings: 

1. Go to [Configuration], select [All Server Documents] and choose your corresponding 
server.  

2. [Disable] Transactional logging at Basics 

3. Go to [Control Panel] -> [Administrative Tools] -> [Services] and restart [Lotus 
Domain Server] Service 

4. Go to [Configuration] -> select [All Server Documents] and enable Transaction 
logging 

5. Make sure your logging style is "Archived" 

6. Go to [Services] and restart Lotus Domain Server Service again 

 
^Back to top 

2.58. How do I restore a machine from my SystemState backup? 

To recovery a machine from scratch, you have to do the followings: 

1. Re-install the operating system 

2. Re-install all applications installed (You can do both of these easily by backing up the 
system yearly using Norton Ghost) 

3. Restore the SystemState backup onto the recovered machine (This will update the 
recovered system with the latest configuration and settings) 

4. Restore all data files onto the recovered system. 

 
^Back to top 
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3. Common Error Messages 

3.1. "Quota Exceeded"  

This means that the backup account has run out of its allocated quota. Please contact your 
administrator (or backup services provider) to increase your backup quota. 
 
^Back to top 

3.2. "Access is denied"  

This means that the file is not accessible by NetBackup Manager. Please check if the system 
account that runs OBM has read access permission to the mentioned file. 
 
^Back to top 

3.3. "Checksum incorrect" / "Uploaded file size incorrect" 

This error occurs when the backup file uploaded to the server is corrupted. Corrupted backup 
files would not be stored on the backup server but will be uploaded to the backup server again 
in the next backup job. 
 
If more than one backup job of the same backup set is being run on more than one computer 
at the same time, you might get this error. Please check if you have installed the client 
software (NetBackup Manager) with the same backup account on more than one computer. 
 
Also, please check the file C:\Program Files\NetBackup Manager\home.txt and see if you 
have more than one “.obm” record (e.g. C:\Documents and Settings\Administrator\.obm) in 
this file that refers to the same backup account on the server. If you can find such entries, 
simply remove the redundant lines from this file and restart the computer. 
 
Sometimes, this problem could be caused by network instability. If this only happens 
occasionally, you can safely ignore this error. 
 
^Back to top 

3.4. "File 'obm-delta.tmp' does not exist on server" / "File 
'obm-chksum.tmp' does not exist on server" 

For NetBackup Manager v5.0.1.4 or before, please: 

1. Upgrade your NetBackup Manager to a newer version. 

2. Delete the obm-delta.tmp or/and obm-chksum.tmp files from your “temporary 
backup directory”, (e.g. C:\Backup\MSExchange\1137065709669).  

 
For later versions of NetBackup Manager, you can simply do step 2 to remove the problematic 
files which were left behind during the backup operations of previous versions. 
 
^Back to top 

3.5. "C:\xxx\yyy\zzz.txt has been removed already"  

There is latency between the backup agent with the list of files to be backed up and the time 
these files are actually backed up. If any of these files are removed between this latency, an 
informative message, “C:\xxx\yyy\zzz.txt has been removed already”, will be logged in the 
backup log report. Under most condition, you don‟t need to worry about this since files 
created and then removed in this situation are usually temporary files. It is used by some 
other applications and it is not necessary to backup these files. 
 
If you are using Infile-Delta, please make sure “Temporary directory for storing backup files” 
setting of your NetBackup Manager is pointing a writable directory with plenty of disk space. 
 
^Back to top 
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3.6. "The process cannot access the file because another process has 
locked a portion of the file"  

You get this message when backing up “C:\xxx\yyy\zzz.txt” because another application has 
held a read-exclusive lock on “C:\xxx\yyy\zzz.txt”. The backup agent, therefore, is unable to 
open the file to read its content. Please try the followings to resolve this problem: 

 Enable the Volume Shadow Copy option for the corresponding backup set if you are 
on Windows 2003 or XP.  

 If you are on an older version for Windows, you may need to obtain a generic “Open 
File Manager” in order to backup the locked files. 

 If the locked file is not important (e.g. C:\pagefile.sys), simply exclude the locked file 
from your backup source. By doing so, this message will not appear again. 

 If the locked file is a database file held open by one of our supported applications 
(e.g. Microsoft SQL Server, Microsoft Exchange Server, Oracle, Lotus Domino/Notes, 
MySQL), simply use the corresponding add-on module provided to backup the 
database. This way, you can backup the database you want (using the application 
specific APIs) without accessing the database file directly. 

 If the locked file is a file held open by some other third party applications, you can use 
the [Pre/Post Command Line Tool] to shutdown/restart the application that is locking 
the file before/after a backup job to make sure that no locks will be placed on files 
that you need to backup.  

 
^Back to top 

3.7. "The process cannot access the file because it is being used by 
another process"  

This means that the file is currently locked by another process (or program). Please 
shutdown the program locking this file before running the online backup program again. You 
can also refer to “What do I have to do in order to backup open files” for more information (for 
file backup set only). 
 
^Back to top 

3.8. "Premature end of input"  

It means that the client software has problem downloading the list of files to be backed up 
from the backup server. It then retries getting the list again. This is nothing to worry about. 
NetBackup Manager would log this as information rather than warning to avoid raising false 

alarm. 
 
^Back to top 

3.9. "Invalid XML Character" / "XML document structures must start 
and end within the same entity" 

Please try the followings: 

1. Logon to the web interface of this backup account 

2. Go to the [File Explorer] page and browse to the directory reported that contain this 
problem (or some other directories) 

3. Check if there are any filenames containing strange characters and delete them 

4. Try backup again. 

 
Also, please try increasing the "connectionTimeout" attribute within the "Connector" tag 
inside [OBS Home]\conf\server.xml to a larger value (e.g. connectionTimeout="180000" or 
connectionTimeout="600000"). This should help solve the problem. 
 
^Back to top 
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3.10. "Incorrect Function"  

Please check if you have any antivirus or personal firewall software installed. Kindly disable 
it from scanning the related data and traffic to see if the problem persists. 
 
^Back to top 

3.11. "HTTP/1.1 502 Proxy Error"  

The specified Secure Sockets Layer (SSL) port is not allowed. ISA Server is not configured to 
allow SSL requests from this port. Most Web browsers use port 443 for SSL requests. 
Refer to http://support.microsoft.com/kb/283284  
 
^Back to top 

3.12. " [Microsoft][ODBC SQL Server Driver][SQL Server]The statement 
BACKUP LOG is not allowed while the recovery model is SIMPLE" 

You need to change the Recovery model to FULL. If you are using Microsoft SQL Server 
7.0/2000, please refer to the following screenshots: 

1. http://download.NetAccess.com/support/screenshots/SQL7-TuncateLogOnCheckpoi
nt.jpg  

2. http://download.NetAccess.com/support/screenshots/SQL2000-FullModel.jpg  

 

If you are using MSDE, please issue the following commands: 

osql -E -S [Server Name] -Q "ALTER DATABASE [Database Name] SET RECOVERY FULL" 
 
These will enable transaction logging option for your MSDE databases and allow 
incremental/differential backup to be run with no problems. 
 
^Back to top 

3.13. "CExBackup::backupService:HrESEBackupSetup: Error Number 
0xc800020e: An incremental backup cannot be performed when 
circular logging is enabled" 

You need to disable circular logging in MS Exchange. Please uncheck the [Enable circular 
logging] option as shown below and restart the “Microsoft Exchange Information Store” 
service after you are done. 

http://support.microsoft.com/kb/283284
http://download.ahsay.com/support/screenshots/SQL7-TuncateLogOnCheckpoint.jpg
http://download.ahsay.com/support/screenshots/SQL7-TuncateLogOnCheckpoint.jpg
http://download.ahsay.com/support/screenshots/SQL2000-FullModel.jpg
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^Back to top 

3.14. "CExBackup::backupStorageGroup:HrESEBackupTruncateLogs: 
Error Number 0xc7ff1004: (null) " 

This is an error returned by the Microsoft API and is a Microsoft issue. Please try to restart the 

"Microsoft Exchange Information Store” service. If the problem persists, you may want to 
schedule the service to restart on a daily basis. 
 
^Back to top 

3.15. "CExBackup::backupStorageGroupLog:HrESEBackupGetLogAnd
PatchFiles: Error Number 0xc8000232: Some log or patch files are 
missing" 

If you have just disabled the MS Exchange circular logging option, please try running a full 
backup again, this should fix the problem. 
 
^Back to top 

3.16. "CExBackup::backupFile:WriteFile: Error Number 0x6: The handle 
is invalid"  

This is the MS Exchange having problem in writing to the Temporary spooling directory. 
Please ensure that the system account running the MS Exchange has full access right to that 
directory. If it is a network drive, please use an UNC path (e.g. \\server\share), and the 
“Network Resources Authentication for Windows” is properly set for the corresponding 
backup set. 
 
^Back to top 

3.17. "Path „C:\Temp\MSSQLServer\1137040769567‟ does not exist" 

If you get this error while you are doing MS SQL or MS Exchange backup, please try to use an 
UNC path (e.g. //server/share) in "Temporary directory for storing backup files" under 
[Backup Source Settings]. Please make sure that your OBM is on the same machine as your 
MS SQL or MS Exchange. Please also ensure that you have included the appropriate 
“Network Resources Authentication for Windows” information in the backup set. 

file:\\server\share
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For MS SQL Server, you may want to check whether if it can spool the database file correctly 
by running the following command: 
 
(Windows Authentication mode) 
osql -E -Q "DECLARE @dbname char(64) SET @dbname = 'xxx' BACKUP DATABASE 
@dbname TO DISK = '//server/share/abc.txt' WITH SKIP" 
 

OR 
 
(SQL Server Authentication mode) 
osql -U USERNAME -P PASSWORD -Q "DECLARE @dbname char(64) SET @dbname = 'xxx' 
BACKUP DATABASE @dbname TO DISK = '//server/share/abc.txt' WITH SKIP" 
 
Note:  

USERNAME/PASSWORD = the database username/password 
xxx = the database that you would like to backup 
//server/share/abc.txt = the location for the database spooling file 
 
^Back to top 

 

 

3.18. "Expect log sequence 'xxx' but found 'SERVERNAME\Microsoft 
Information Store\First Storage Group\E000xxx.log'" 

This occurs when the log sequence of MS Exchange was altered by other backup software, 
e.g. NTBackup. Thus when the Backup Manager next performs a MS Exchange backup, the 
Exchange log sequence would not match the one that it is expecting. With the broken 
sequence, the Exchange server cannot be restored to its latest state.  
 
To resolve this problem, you need to deactivate all other backup software that is operating on 
MS Exchange, and then you need to perform a Full MS Exchange database backup manually 
via the Backup Manager. 
 
Alternatively, instead of backing up transaction logs during the weekdays, you can consider 
doing Full Exchange Database backup on a daily basis with the In-File Delta option enabled. 
This should avoid interference from other backup software while keeping the amount of 
upload data to minimal. 
  
^Back to top 

3.19. "The last backup jobs of *.stm (2006-10-30-13-40-21) and *.edb 
(2006-11-04-03-05-00) don‟t match for database 'ServerX\Microsoft 
Information Store\First Storage Group\Mailbox Store (ServerX)'" 

For MS Exchange backup, *.stm and *.edb are backed up in pairs, if this error occurs, it 
implies that during a previous backup, there was a problem with either the *.stm or *.edb 
file. If this happens, please perform a Full MS Exchange backup manually via the Backup 
Manger to resolve this problem. 
  
^Back to top 

3.20. "No *.stm found for database 'ServerX\Microsoft Information 
Store\First Storage Group\Mailbox Store (ServerX)'" 

This suggests that the .stm file on server may have been corrupted or found missing. To 
resolve this error, please perform a Full MS Exchange backup manually via NetBackup 
Manager. 
  
^Back to top 
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3.21. Exception in thread "main" java.lang.UnsatisfiedLinkError: 
/usr/local/obm/jvm/lib/i386/libawt.so: libXp.so.6: cannot open 
shared object file: No such file or directory… 

This is caused by a missing library in Fedora Core 6. To resolve this, just open a terminal window. 

From here type in the command 'yum install libXp' (please note that the command is case sensitive), this 

will ask you if it is ok to download the package. Just type 'Y' and the libXp library will be installed. Once 

installed, just run the command  

 
"sh $OBM_HOME/bin/RunBackupManager.sh"  

 

You should find that the NetBackup Manager will open up and you should be able to create the backup set 

via the GUI interface.  

 

When running the 'yun install' command, you may see the following error:  

 

Loading "installonlyn" plugin  

Existing lock /var/run/yum.pid: another copy is running. Aborting.  

 
This is because the background YUM updater service is running. To stop it, run:  

 

/etc/init.d/yum-updatesd stop  

 

Once the process has been stop, you should be able to run the command 'yum install libXp' without any 

problems. 
  
^Back to top 
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